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Introduction 

This Job Aid provides a detailed overview of the CONNECTIONS system changes being 
introduced with Build 18.9.6 and specifically information about updates to the Tracked Children 
Detail and Finalize Adoption windows that accommodate the Adoption and Foster Care Analysis 
and Reporting System (AFCARS). This Job Aid is intended for all CONNECTIONS users who 
will be responsible for recording foster care and adoption information in CONNECTIONS.  

Specifically, this Job Aid contains information about enhancements to the following functional 
areas: 

• Tracked Children Detail window 

• Program Choice/PPG tab 

• Removal Information tab 

• Placement Information tab 

• FASP Components: Appropriateness of Placement and Plan Amendment 

• Finalize Adoption 

• AFCARS Adoption Information window 

 

 

 
Any visible identifying data in this Job Aid is 
simulated and has not been taken from the 

Production Database. 
 

This Job Aid assumes familiarity with the 
CONNECTIONS system. 

 
 

This Job Aid is available on the CONNECTIONS intranet site: 
OCFS intranet home page > CONNECTIONS > Step-by-Step/Job Aids/Tips 

The OCFS CONNECTIONS intranet site also contains information about trainings offered to 
support you in your work in CONNECTIONS. 



 

Introduction to Adoption and Foster Care Analysis and 
Reporting System (AFCARS) 

Federal law and regulation requires states to report certain data on foster and adopted children.  
To meet these requirements, the Adoption and Foster Care Analysis and Reporting System 
(AFCARS), developed by the Department of Health and Human Services (DHHS), collects case 
level information on all children in foster care, and on those foster children who are adopted. 
AFCARS also collects information on foster and adoptive parents.  

CONNECTIONS and other legacy systems, principally the Child Care Review Service (CCRS), 
are the data sources that meet federal reporting requirements. With the implementation of Build 
18.9.6, CONNECTIONS has been enhanced to capture additional AFCARS information on the 
Removal Information and Placement Information tabs and on the Finalize Adoption window.  
 

Functionality of AFCARS in CONNECTIONS 
Prior to Build 18.9.6 workers recorded some foster care and related adoption information on the 
Tracked Children Detail window tabs (e.g., Program Choice/PPG, Placement and Removal 
Information tabs), pertinent sections of the FASP, and the Finalize Adoption window. With the 
implementation of Build 18.9.6, additional AFCARS information will be collected. For example, 
the Placement Information tab on the Tracked Children Detail window features a new 
AFCARS Foster Care Information section. In addition, a new AFCARS Adoption Information 
window has been added to CONNECTIONS that captures additional adoption reporting 
elements.  

Build 18.9.6 will also provide warning messages on various windows and tabs during entry to 
remind workers to complete AFCARS information. The new AFCARS fields will be denoted by 
an asterisk (*), which identifies the information as AFCARS data elements. 

Furthermore, the principal sources of AFCARS information are derived from the Permanency 
Planning Goal (PPG) information (e.g., PPG selection), the Child Care Review Service (CCRS), 
and the Welfare Management System (WMS). Additional foster care-related AFCARS 
information will be derived from the Type of Legal Event Associated with Removal* (e.g., 
Manner of Removal) field on the Removal Information tab, Caretaker Information (e.g., 
Relationship Matrix) and Health Services (e.g., Clinical Appointments) information in 
CONNECTIONS.  
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Tracked Children Detail Window 

With the implementation of Build 18.9.6, various features on the Program Choice/PPG, 
Placement Information and Removal Information tabs on the Tracked Children Detail window 
have been enhanced to accommodate additional AFCARS reporting. For example, a new 
AFCARS Foster Care Information section displays on the Placement Information tab. In 
addition, fields that are AFCARS elements are denoted an asterisk (*). 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

 

Step-by-Step: 
Accessing the Tracked Children Detail window from the Assigned Workload 

2 Select the appropriate FSS stage on the Assigned Workload. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Family Services Stage window displays. The Stage Composition tab is active. 

4 Click on the Family Assessment and Service Plan tab. 
The FASP window displays. 

5 Click on the Tracked Children button.  
The Tracked Children Detail window displays. The Program Choice/PPG tab is the 
active tab. 

 

Program Choice/PPG Tab 
With the implementation of Build 18.9.6, upon entry into the Tracked Children Detail window, all 
tabs on the window will be enabled. Once data is modified or new choices are added on the 
Program Choice/PPG tab, the Placement Information, Associated Caseworker, and 
Removal Information tabs will be disabled. Once an entry is saved and the selected child has 
a program choice of Placement, all tabs will be enabled. If the child selected does not have a 
Program Choice of Placement or a history of Placement, the Removal Information tab will not 
be enabled. The Select Children grid will be populated with all currently tracked children and all 
other children available to be tracked in the stage. Any child that is currently tracked in another 
stage is not populated in the grid. 
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Adding a Program Choice 
With the implementation of Build 18.9.6, when the Program Choice field of the selected 
child(ren) is changed to Placement and saved, the system displays the following warning 
message: “Complete/Verify AFCARS FC Information on Placement Information tab” on the 
bottom corner of the tab to remind you to record AFCARS foster care information. This message 
will clear when the Program Choice of Placement is end-dated and saved for the selected 
child(ren).  
 
To record and verify AFCARS foster care information, click on the Placement Information tab 
on the Tracked Children Detail window and select a child with a Program Choice of Placement 
from the Select Child grid. If information exists for the selected child, it will be displayed in the 
AFCARS Foster Care Information section. Verify that the information is correct and make any 
corrections needed. If no AFCARS foster care information exists, record and save the AFCARS 
foster care information. 

When the Program Choice is modified while a FASP is in process and there are no longer any 
children in Placement, the AFCARS message will not be displayed.  
 

Page 4 
CONNECTIONS System Build 18.9.6 AFCARS Job Aid v1.0 (3/3/2008) 



 

Placement Information Tab 
With the implementation of Build 18.9.6, upon entry into the Tracked Children Detail window, the 
Placement Information tab will be enabled. The Select Child grid will include all non-end-
dated children in the stage and will no longer be restricted to children with a Program Choice of 
Placement. The grid will contain a checkbox that will be checked by the system if the child’s 
Program Choice is Placement.  

In addition, with Build 18.9.6, an AFCARS Foster Care Information section has been added to 
the Placement Information tab that will allow you to record and view AFCARS foster care 
information. This section will be displayed for FSS/CWS and FSS/CCR stages. Any worker with 
a role in the FSS/CWS or FSS/CCR stage, as well as any user with access to that worker’s 
Assigned Workload, may view and modify AFCARS foster care information.  

1 On the Tracked Children Detail window, click on the Placement Information tab. 
The Placement Information tab displays. 

 

 

Step-by-Step: 
Accessing the Placement Information Tab  

Selecting a child in Placement from the Select Child grid will display the Name of the 
Discharge Resource. If there is placement information in CCRS for the child, the information 
will be populated on the CCRS section of the window. Review the CCRS information to ensure 
that it is accurate. If any of the information is incorrect, correct the information before 
proceeding.  
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The AFCARS Foster Care Information section contains questions regarding the foster care 
family structure and history of previous adoptions including international adoption information.  
The AFCARS fields are as follows: 
 

Field Name Description Condition 

Child placed in 
Congregate Care? 

This field is used to record if the 
selected child is placed in congregate 
care.  

When recorded, the Foster 
Family Structure field will be 
cleared and disabled.  

The field Has the child been 
previously adopted?* must be 
completed. 

Foster Family Structure* This field is used to record the marital 
status of the foster family at the time of 
placement. It is defined with an * sign to 
identify it as an AFCARS element. 
Responses are selected from a drop-
down list. The available selections are 
Married couple, Unmarried couple, 
Single female, and Single male.  

When recorded, the Child 
placed in Congregate Care 
field will remain disabled and be 
unchecked.  
 
The field Has the child been 
previously adopted?* must be 
completed. 

Has the child been 
previously adopted?* 

This field is used to indicate whether the 
selected child was previously adopted. 
It is defined with an * sign to identify it 
as an AFCARS element. A response is 
recorded by checking the appropriate 
radio button. Valid responses are Yes, 
No, and Unable to Determine. 
 

If response is Yes, the fields 
Was the child adopted 
internationally? and How old 
was the child when the 
adoption was finalized?, will 
be enabled and must be 
completed. 
 
If the response is No or Unable 
to determine, the Save and 
Cancel buttons will be enabled. 

 
The Foster Family Structure (or Child placed in Congregate Care) and Has the child been 
previously adopted? fields are required. Once information is recorded in a field, the  
Cancel button is enabled. The Save button is enabled when all required fields are complete. 
 
Was the child adopted 
internationally? 

This field is used to indicate whether the 
selected child was adopted 
internationally. A response is selected 
by checking the appropriate radio 
button. Valid responses are Yes and No. 

If response was Yes to the field 
Has the child been previously 
adopted?* this field must be 
completed. 

 
How old was the child 
when the previous 
adoption was finalized?* 

This field is used to record the age of the 
selected child when the previous 
adoption was finalized. It is defined with 
an asterisk (*) to identify it as an 
AFCARS element. A response is 
selected from a drop-down list. The 
available selections are: Less than 2 
years, 2 to 5 years, 6 to12 years, 13 
years or older, and Unable to determine. 

If response was Yes to the field 
Has the child been previously 
adopted?*, this field must be 
completed. 
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The most recent AFCARS foster care information saved in the FSS/CWS stage will be carried 
forward to the FSS/CCR stage and will be displayed in the respective section for the selected 
child. Only the most recently saved information will be displayed in the AFCARS Foster Care 
Information section. 
 
For a FSS/CWS stage with the selection of a child(ren) not in Placement (F/C field is not 
checked), the AFCARS Foster Care Information section will display previously saved 
information, if it exists. However, all fields in the window, including those in the AFCARS Foster 
Care section, will be disabled and are view-only. When a child with an active Placement (F/C 
field is checked) is selected, the AFCARS Foster Care Information section will display 
previously saved information, if it exists, and all fields will be enabled and can be modified.  
 
For a FSS/CCR stage, only the selected child’s previously saved information, if it exists, is 
displayed in the AFCARS Foster Care Information section. All fields on the window, including 
those in the AFCARS Foster Care section, will be enabled and can be modified. 
 
AFCARS Foster Care Information cannot be partially saved (e.g., only one or two fields 
completed and saved, then other fields completed at another time) on the Placement tab. All 
required fields must be recorded in order to enable the Save button. 
When the AFCARS Foster Care Information is modified, the previously saved information will be 
replaced with the new information. There is no history of changes maintained. When all required 
information has been recorded, the Save and Cancel buttons will be enabled. The Cancel 
button will be enabled whenever a change is made to the window. 

 

 

Step-by-Step: 
Recording AFCARS Foster Care Information on the 
Placement Information Tab 

1 Select a child with a Program Choice of Placement 
from the Select Child grid by clicking on the box to 
the left of the child’s name. 

2 If the selected child was placed in congregate care, 
click on the Child Placed in Congregate Care 
checkbox and skip to Step 4 below. Otherwise, 
continue to Step 3.  

3 Click on the drop-down arrow in the Foster Family 
Structure* field and select the appropriate 
response. 

 

Where am I? 

Assigned Workload > Tasks > 
FSS > Tracked Children Detail > 

Placement Information tab 

4 Click on the appropriate radio button in the Has the child been previously 
adopted?* field to answer the question. If the answer is No or Unable to determine, 
the remaining fields are disabled; skip to Step 7 below. 

5 Click on the appropriate radio button in the Was the child adopted internationally? 
field to answer the question. 

6 Click on the drop-down arrow in the How old was the child when the previous 
adoption was finalized? * field and select the appropriate response. 

7 Click on the Save button.  
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1 On the Tracked Children Detail window, click on the 
Placement Information tab. 

2 Select a child with an active or historical Program 
Choice of Placement from the Select Children grid 
by clicking on the box to the left of the child’s name. 
The child’s AFCARS information displays in the 
AFCARS Foster Care Information section.  

 
 

Child Completely Freed for Adoption and Name of Discharge Fields 
With the implementation of Build 18.9.6, the existing functionality of the fields Name of the 
Discharge Resource and Completely Freed for Adoption remains the same. When either of 
these fields is completed (with or without entering or modifying AFCARS information), the Save 
button will be enabled. Please note that the Completely Freed for Adoption checkbox is only 
visible to the Case Manager or those with access to the assigned Workload of the Case 
Manager. 
 
Removal Information Tab 
With the implementation of Build 18.9.6 a new field, Conditions 
Associated with Child’s Removal*, has been added to the 
Removal Information tab to allow workers to record additional 
information regarding circumstances or conditions associated 
with the child’s removal for AFCARS reporting. If the Program 
Choice is Placement, recording of the Conditions Associated with Child’s Removal is required; it 
is optional if the Program Choice is Non LDSS Custody. The conditions will be selected from a 
checkbox listing; one or more boxes may be checked. In addition, AFCARS fields (e.g. Type of 
Legal Event Associated with Removal* and Conditions Associated with Child’s Removal*) 
are denoted with an asterisk (*). 

1 On the Tracked Children Detail window, click on the 
Removal Information tab.  
The Removal Information tab displays. When more 
than one child appears in the grid, the grid displays in 
youngest child order. 

 

 

 

Step-by-Step: 
Viewing previously recorded AFCARS Foster Care Information on the 
Placement Information Tab 

 

Where am I? 
Assigned Workload > Tasks > 

FSS > FASP > Tracked 
Children Detail > Placement 

Information tab 

 
In order to access the Removal 
Information tab, the child must 

have a current or historical 
Program Choice of Placement. 

 

Step-by-Step: 
Accessing the Removal Information Tab 

 
Where am I? 

Assigned Workload > FSS > 
Tasks  > Tracked Children 

Detail 



 

 
 
Upon opening the Removal Information tab, children will display in the Select Child grid from 
in order from youngest to oldest. The removal records in the Removal Information grid will be 
displayed in descending order (most recent on top and the oldest on the bottom), which cannot 
be modified (i.e., the columns cannot be sorted). 
 
The following circumstances or conditions are available for selection in the Conditions 
Associated with Child’s Removal* field: 

• Abandonment 
• Alcohol Abuse (Child) 
• Alcohol Abuse (Parent) 
• Child's Behavior problem 
• Child's Disability 
• Caretaker's inability to cope due to Illness or other reasons 
• Drug Abuse (Child) 
• Death of Parent(s) 
• Drug Abuse (Parent) 
• Inadequate Housing 
• Incarceration of Parent(s) 
• Neglect  
• Physical Abuse 
• Relinquishment 
• Sexual Abuse 
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When adding a new removal record, if the selected child has a Program Choice of Placement, 
the fields Date of Physical Removal, Type of Legal Event Associated with Removal * and 
Conditions Associated with Child’s Removal* are required in order to add a new removal 
record to the Removal Information grid. When the selected child has a Program Choice of 
Non-LDSS Custody, only the Date of Physical Removal and Type of Legal Event Associated 
with Removal* fields are required. The Cancel button enables as soon as you start to record 
information. The Save button enables only when all the required fields have been completed.  

When a record is selected on the History of Removals grid, the Date of Physical Removal, 
Type of Legal Event Associated with the Removal* and Conditions Associated with 
Child’s Removal* information (if previously recorded) will be system-populated and can be 
modified. If the Program Choice is modified from Non-LDSS Custody to Placement and the 
Conditions Associated with the Child’s Removal has not been recorded, the warning message 
“Complete/Verify AFCARS FC Information on Placement Information tab” displays on the 
Program Choice/PPG tab; removal information and Conditions Associated with Child’s 
Removal* information will be required. The Save button will not be enabled until the required 
field is completed.   

After modifying the required fields (i.e., Date of Physical Removal, Type of Legal Event 
Associated with Removal and Conditions Associated with Child’s Removal [applicable 
only for Placement]), the Save button will be enabled and all tabs will be disabled. The Cancel 
button will enable as soon as you modify information in any field. 

Selecting a record in the History of Removals grid enables the Clear button. Clicking on this 
button with a record highlighted clears the data fields. Clicking on this button when recording a 
new record clears the newly recorded information.  
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FASP Components 
FASP – Foster Care Issues Node – Appropriateness of Placement 
 
With the implementation of Build 18.9.6, in a FSS/CSW or 
FSS/CCR stage, when the worker clicks on the Child has 
entered or reentered foster care and or the Child has been 
moved from one foster care setting to another 
checkbox(es) on the Appropriateness of Placement sub-
node, the message “Complete/Verify AFCARS FC 
Information on Tracked Child Detail - Placement 
Information tab” displays to remind workers to record and 
verify AFCARS foster care information. Clicking on the OK 
button on the message window redisplays the Appropriateness 
of Placement sub-node window. This time when you click on 
the OK button on this window, the Appropriateness of 
Placement window will display. 
 
 
 
 
 
 
 
 
 

 

Step-by-Step: 
Opening the Appropriateness of Placement Sub-node 

1 From the Foster Care Issues node, click on the 
Appropriateness of Placement sub-node. 
The Appropriateness of Placement message 
window displays for all FASP types except Initial. If 
Appropriateness of Placement information was 
previously recorded and saved in CONNECTIONS 
or this in an Initial FASP, this message window 
does not display. 

2 Select the applicable checkbox. 
The AFCARS message, “Complete/Verify 
AFCARS FC Information on Tracked Child Detail - Placement Information tab” 
displays. If the Does not apply to any child checkbox was selected, the AFCARS 
message does not display. 

 
To record and verify AFCARS 

foster care information, click on 
the Tracked Children button on 

the Family Assessment and 
Service Plan window, click on 

the Placement Information tab 
on the Tracked Children Detail 

window, and select a child with a 
Program Choice of Placement 

from the Select Child grid. 
Verify that the information is 

correct and make any 
corrections needed. If no 

AFCARS foster care information 
exists, record and save the 

AFCARS foster care information. 
Refer to Recording AFCARS 

Foster Care Information in this 
Job Aid for more information. 

 
Where am I?  

Assigned Workload > FSS > 
Tasks > FASP tab > FASP Tree 

> Foster Care Issues node 

3 Click on the OK button. 
The Appropriateness of Placement sub-node redisplays to allow for additional 
entries. 

4 Click on the OK button. 
The Appropriateness of Placement window displays. 
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FASP – Plan Amendment – Child Entering/Reentering Foster Care 
node or Child Moved from One Foster Setting to Another 
With the implementation of Build 18.9.6, when the “Child 
Entering/Reentering Foster Care” or “Child Moved from One 
Foster Care Setting to Another” status change is selected on 
the Plan Amendment node, the following AFCARS message 
displays to remind you to record and verify AFCARS foster 
care information: “Complete/Verify AFCARS FC Information 
on Tracked Child Detail - Placement Information tab.” 
Clicking on the OK button displays the Appropriateness of 
Placement window.  

 
To record and verify AFCARS 

foster care information, click on 
the Tracked Children button on 

the Family Assessment and 
Service Plan window, click on 

the Placement Information tab 
on the Tracked Children Detail 

window, and select a child with a 
Program Choice of Placement 

from the Select Child grid. 
Verify that the information is 

correct and make any 
corrections needed. If no 

AFCARS foster care information 
exists, record and save the 

AFCARS foster care information. 
Refer to Recording AFCARS 

Foster Care Information in this 
Job Aid for more information. 
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Finalize Adoption 

With the implementation of Build 18.9.6, an AFCARS button has 
been added to the Finalize Adoption window to allow you to 
access the new AFCARS Adoption Information window. The 
AFCARS Adoption Information window will be used to record 
adoptive parent and biological parent information, as well as 
adoption agency information. Any worker assigned a role in the 
FSS/CCR stage can view and modify information. A worker 
must have the ACC SEALED ADOP Business Function to 
access the Finalize Adoption window once the FSS/CCR stage 
is closed; it is not needed to record or view the information when 
the stage is open. Also in Build18.9.6, the message “Complete AFCARS Adoption 
Information” will display on the Finalize Adoption window to remind workers to complete the 
AFCARS adoption information.  

 

Step-by-Step: 
Accessing the Finalize Adoption Window 

 
The AFCARS adoption 
information can only be 

recorded after the Finalize 
Adoption window has been 

completed and saved. 

 

Where am I? 

Assigned Workload > FSS/CCR 
>Tasks  

1 On the FSS Stage Composition tab, click on the 
Options menu and select the Finalize Adoption 
command. 
The Finalize Adoption window displays with the 
AFCARS button disabled.  
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Upon first entry to the Finalize Adoption window—and prior to completing and saving the 
finalization information—the AFCARS button will be disabled. After adoption finalization 
information is recorded, completed, and saved—and upon future entry into the window—the 
AFCARS button will be enabled.  

The AFCARS message, “Complete AFCARS Adoption Information” will be displayed on the 
bottom of the Finalize Adoption window until all AFCARS adoption information has been 
recorded and saved. AFCARS adoption information can be modified until the stage is closed. 

 

AFCARS Adoption Information Window 
With the implementation of Build 18.9.6, a new AFCARS Adoption 
Information window has been added, which allows Case 
Managers and assigned workers to record and view certain 
adoption information pertaining to both the biological and adoptive 
parents, as well as the adoption agency. For closed stages, 
workers with access to the Finalize Adoption window will be able 
to access the AFCARS Adoption Information window as well. The 
AFCARS Adoption Information window is accessed from the 
Finalize Adoption window only after the adoption finalization 
information is saved by clicking on the AFCARS button. The 
Finalize Adoption window must be completed and saved before 
the AFCARS button will enable. Workers will also be allowed to 
navigate to the AFCARS Adoption Information window in view-
only mode once a stage has been closed.  
 

1 Click on the AFCARS button. 
The AFCARS Adoption Information window displays. 

 

 
When entering information for 
a single female or male even 

though all required information 
has been entered the 

message “Complete AFCARS 
Adoption Information will 

continue to display. This will 
be corrected in a future Build 

and can be ignored. 

 

Step-by-Step: 
Accessing the AFCARS Adoption Information window 

 

Where am I? 

Assigned Workload > FSS 
>Tasks > Options 

> Finalize Adoption  

 
The Finalize Adoption window 
must be completed and saved 

in order for the AFCARS 
button to be enabled. 



 

 

 

The AFCARS Adoption Information window is comprised of a header, footer, menu items, and 
various buttons. The header is always visible and includes the Case Name, Person ID, File 
menu, and Help menu. The window is comprised of the following sections: Adoption Finalized 
Child – Adoption Information, Adoptive Mother Demographics, and Adoptive Father 
Demographics. The footer contains the Save, Cancel and Close buttons.  

Upon entry to the AFCARS Adoption Information window, all fields will be enabled and can be 
modified. Once information is recorded in any field, the Save and Cancel buttons enable; the 
Close button is always enabled.  
 
The Adoption Finalized Child – Adoption Information section 

Was biological mother married at time 
of child’s birth? 

This field is used to record the marital status 
of the biological mother at the time of the 
child’s birth. The responses are selected from 
a dropdown list. Valid responses are: Yes, 
No, and Unable to determine. 

Adoptive Family Structure This field is used to record the family 
structure of the adoptive family. The 
responses are selected from a dropdown list. 
Valid responses are: Married Couple, 
Unmarried couple, Single female and Single 
male. If the Adoptive Family Structure is 
either Single female or Single male, record 
the demographic information for either the 
adoptive mother or adoptive father. (When 
entering information for a single female or 
male even though all required information has 
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been entered, the message “Complete 
AFCARS Adoption Information” will continue 
to display; this will be corrected in a future 
Build and can be ignored.) 

Relationship of Adoptive Parent to 
Child 

This field is used to record the relationship of 
the adopted parent(s) to the child. The 
responses are selected from a dropdown list. 
Valid responses are: Stepparent, Other 
Relative, Foster Parent and Other Non-
Relative. 

Location of Adoption Agency This field is used to record the location of the 
adoption agency. The responses are selected 
from a dropdown list. Valid responses are: 
Within the state, and Another state. 

 

Adoptive Mother Demographics Section 

Year of Birth This field is used to record the year of birth of the adoptive mother. 
The year is selected from a dropdown list of years from 1900 to the 
current year.  

Race This field is used to record the race of the adoptive mother. The 
response is selected from a checkbox. Valid responses are: 
American Indian or Alaskan Native, Asian, Black or African 
American, Native American or Other Pacific Islander, White, and 
Unable to determine. More than one race can be recorded. 

Hispanic Origin This field is used to record whether the adoptive mother is of 
Hispanic origin. The response is selected from a dropdown list. 
Valid responses are: Yes, No, and Unable to determine. 

 

Adoptive Father Demographics Section 

Year of Birth This field is used to record the year of birth of the adoptive father. 
The year is selected from a dropdown list of years from 1900 to the 
current year. 

Race This field is used to record the race of the adoptive father. The 
response is selected from a checkbox. Valid responses are: 
American Indian or Alaskan Native, Asian, Black or African 
American, Native American or Other Pacific Islander, White, and 
Unable to determine. More than one race can be recorded. 

Hispanic Origin This field is used to record whether the adoptive father is of 
Hispanic origin. The response is selected from a dropdown list. 
Valid responses are: Yes, No, and Unable to determine. 
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The following buttons display on the bottom of the AFCARS Adoption Information window: 

Save  Clicking on this button saves modifications that have been made. 

Cancel When you click on the Cancel button, the following message displays: 

“Do you want to cancel? Unsaved data and/or narrative(s) will be lost.” 

• Click on the Yes button to close the window without saving the 
information.  

• Click on the No button to leave the window open; all changes 
remain pending. 

 
Close Clicking on this button closes the window and displays the Finalize 

Adoption window. If any unsaved changes exist on the window when you 
click on this button, the following message displays: 

“Do you want to Exit? 
Unsaved data and/or narrative(s) will be lost.” 

 
• Clicking on the Yes button discards the unsaved changes and 

closes the window. 
• Clicking on the No button closes the message without closing the 

window; all changes remain pending. 
 

 

 

Step-by-Step: 
Recording AFCARS Adoption Information 

1 Click on the drop-down arrow in the Was biological 
mother married at time of child’s birth? field and 
select the appropriate response.  
The Save and Cancel buttons enables. 
  

Where am I? 

Assigned Workload > FSS 
>Tasks > Options 

> Finalize Adoption > 
AFCARS Button 

2 Click on the drop-down arrow in the Relationship of 
Adoptive Parent to Child field and select the 
appropriate response. 

3 Click on the drop-down arrow in the Adoptive Family 
Structure and select the appropriate response. 

4 Click on the drop-down arrow in the Location of Adoption Agency field and select 
the appropriate location. 

5 In the Adoptive Mother Demographics section, if applicable, click on the drop-down 
arrow in the Year of Birth field and select the appropriate year. 

6 In the Race field, click on the race of the adoptive mother. 

7 In the Hispanic Origin field, click on the drop-down arrow and select the appropriate 
response. 
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8 In the Adoptive Father Demographics section, if applicable, click on the drop-down 
arrow in the Year of Birth field and select the appropriate year. 

9 In the Race field, click on the race of the adoptive father. 

10 In the Hispanic Origin field, click on the drop-down arrow and select the appropriate 
response. 

11 Click on the Save button.  
The adoption information is saved and the AFCARS Adoption Information window 
displays. 

12 Click on the Close button. 
The Finalize Adoption window displays. 
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Support Tools 

Online Help 
CONNECTIONS Online Help provides descriptions for various windows, as well as step-by-step 
instructions for common tasks. You can access Online Help at any time, from any window in 
CONNECTIONS by clicking on the Help menu or pressing the F1 key on your keyboard. 

The Contents, Index and Search tabs in Online Help allow you to search for and navigate to 
the topic(s) you need help on. 

 

Step-by-Step: 
Accessing Online Help 

1 Click on the Help menu on the CONNECTIONS Toolbar. 
The following list of commands displays: 

Contents A table of contents for the help facility with links to major sections. 
How Do I? Step-by-instructions to help you complete tasks using 

CONNECTIONS.  
Window 
Descriptions 

Descriptions of windows in CONNECTIONS, along with information on 
various fields. 

DSS Policy Online OCFS policy handbooks (under revision). 
Help On This 
Window 

Window description help for the window you are on. 

Help for Help Instructions on how to use the help functionality.  
About 
CONNECTIONS 

Information about the current CONNECTIONS version and build. 

2 Click on a command from the Help menu. 
The window related to your selection displays. In some cases, you will need to make 
another selection in that window to obtain instructions. At the top of each window you 
will see additional buttons and menus. Use the Search button to search for specific 
information in the Help function and use the Back button to return to windows you 
have just visited in Help. The Glossary button opens a list of important 
CONNECTIONS terms and the Print button allows you to print Help information. 

3 When you are done reviewing information in Help, close each Help window by 
clicking on the Close button ( ) in the top right corner of the window. 
The system returns to the window you were using when you accessed Help. 
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Enterprise Help Desk 
The New York State Office for Technology (NYS OFT) Enterprise Help Desk staff is available to 
answer basic questions related to your equipment or to solve problems you are having with the 
CONNECTIONS application. If they cannot solve your problem, they will record your information 
and forward it to others who can. 

Your agency may have procedures in place for contacting the Enterprise Help Desk. Check with 
your supervisor before you call. 

The Enterprise Help Desk is staffed 24 hours a day, seven days a week. The telephone number 
is: 

1-800-NYS-1323 

1-800-697-1323 

When you call the Enterprise Help Desk with a problem, you will be given a ticket number to use 
for tracking your issue and its resolution. Keep a record of this number; you will need it for any 
follow-up conversations with the Enterprise Help Desk. 

OCFS CONNECTIONS Intranet Site 
A variety of training-related materials are available from the OCFS CONNECTIONS intranet site 
(http://ocfs.state.nyenet/connect/). The intranet site contains a wealth of information related to 
various aspects of CONNECTIONS, including training schedules, Alerts and Notices, Step-by-
Step Guides (including the CONNECTIONS Case Management Step-By-Step Guide), Job Aids 
and Frequently Asked Questions (FAQs). Release Notes – a complete list of the modifications, 
enhancements, fixes and impacts in the Build – is also available from the CONNECTIONS 
intranet site. 

 

Step-by-Step: 
Accessing the OCFS CONNECTIONS Intranet Site 

1 From your local desktop, double-click on the Internet Explorer icon. 

2 If the browser does not display the OCFS intranet site automatically, enter 
http://ocfs.state.nyenet into the browser’s address line and press the Enter key on 
your keyboard. 
The OCFS intranet home page displays. 

3 Click on the CONNECTIONS link. 
The CONNECTIONS home page displays. 

4 Click on a topic to access information. For access to various Step-by-Step Guides 
and Job Aids, click on the Step-by-Step/Job Aids/Tips link. For access to Release 
Notes for a Build, click on the Implementation link. 

5 To close Internet Explorer, click on the File menu and select Close. 
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